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Appendix A - Smart Desktop 
 

By personalizing your Smart Desktop, you can choose and rearrange items displayed on the desktop that pertain to 

your work. To see the Smart Desktop, click the Desktop menu tab ( ) in the Workarea’s upper right corner. 

 

The Smart Desktop looks like this. 

 

The default Smart Desktop page contains Widgets that provide information about your website. The page above 
shows the default widgets for the Ektron Medical starter site. 
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How to Personalize the Smart Desktop 
(Refer to “Personalizing the Smart Desktop” section of “The Workarea and Smart Desktop” chapter in Ektron 
CMS400.NET Reference Manual) 

 

The Ektron CMS400.NET Workarea can have multiple tabs, letting you organize content by subject – think of tabbed 
browsing. You can easily add new tabs and switch between them. Within a tab, you can add, move or delete Widgets 
for your own personalized Smart Desktop. 

 

 

 

Widgets that you use on the Smart Desktop are stored in a widget tray. You can drag and drop widgets from the tray 
onto the Smart Desktop into any tab and column. 

 

 
 

You control the arrangement of the Smart Desktop Widgets for your own profile. 
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Adding a Widget into the Smart Desktop 
 

Go to the Workarea > Desktop and follow these steps 

1. Click Toggle Widget Tray located in the upper right corner of the Smart Desktop window (circled below). 

 

2. Next you see the Widget Tray containing widgets that you can drag and drop onto your Smart Desktop. Use the left 

arrow ( ) or right arrow ( ) buttons to see more widgets. 

3. Choose the widget you wish to use by dragging and dropping it from the tray into the Smart Desktop panel. 

 

 

 

Once you have placed the widget into the Smart Desktop, you may drag it to any location on the desktop. 

 

Adding a Tab to the Smart Desktop 

Tabs help you organize your Smart Desktop. By default, there is one tab containing a few standard widgets. You may 
wish to add other tabs for eCommerce or Analytics type 
widgets. 

To add an eCommerce widget for example, do the following 

1. Click the Options button on the upper right of the Smart 
Desktop. 

 

2. Click on Add Tab. You next see the Add Tab dialog window. 
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3. Enter the Tab Label for the tab “Analytics”. 

 

4. Click OK to save the Tab Label. 

 

The new tab appears on the top of the Smart Desktop. 
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Adding Columns 
By default, 3 columns are placed on the Smart Desktop. You may add columns by following these steps. 

1. Click the Options button on the upper right of the Smart Desktop. 

 
2. Click Add Column. 

3. Click the Options button to see the columns below the Widget tray. 

 

 

4. Now that you have four columns, search for the analytics report widget in the widget tray. 

5. Drag and drop the analytics control into the first column. 

NOTE: If your developers have not set up your analytics provider you will see the following error message when you 
try this exercise ‘Username and/or password not set. Please update the AnalyticsDataProvider section on your 
web.config. Parameter name: Username, Password’. 
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Restoring Tabs and Widgets 
All users can restore their Smart Desktops to the Default Widget 

set. To do this, follow these steps. 

 
1. Click the Options button on the right side of the Smart Desktop. 

2. Click Remove Widgets and Tabs. 

3. When the dialog box appears that confirms you want to delete 

all Tabs and Widgets, click OK. 

 

Setting the Default Widgets 
To restore Default Widgets, you must be a member of the Administrators group. 

Refer to ”Restoring Tabs and Widgets” section of the Ektron CMS400.NET Reference Manual to restore Smart Desktop 
to the Default Widget set. The Default Widget set is defined by users in the Administrators group by doing the 
following. 

1. Click the Options button on the right side of the Smart Desktop. 

2. Click Edit Default Widgets. 

 
3. Arrange the Smart Desktop with Tabs and Widgets that you wish to be the default. 

4. Click the Options button. 

5. Click Done to save the Default Smart Desktop. 

 
 

Work area menu tabs are shown below 
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Appendix B – Managing Folders 
 

Working with Folders 
Folders are provided to CMS Users for organizational and navigation purpose of site content. 
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Creating & Editing Folders 
Folders contain content items and also have properties which we will learn to set later in the training. 

Creating a New Folder 
For this instruction we will create a sub folder under the Your Refuge > Section > Multimedia > Galleries folder as an 
example. 

1. In the Workarea, select the Content tab. 

2. Navigate to Your Refuge > Section > Multimedia > Galleries folder.  

3. In the right pane toolbar, select New > Folder.  

4. In the Name field, enter “Audio”. 

5. Click the Add Folder button ( ) to create the folder or skip to the Edit Folder Properties section below. 

Edit Folder Properties 

1. In the Workarea, click on the Content tab. 

2. Navigate to Your Refuge > Section > Multimedia > Galleries > Audio folder.  

3. On the View menu, select Properties.  

 



 

325 | P a g e  

 

4. Click the Edit button ( ) in the Folder Properties Toolbar. 

 

Taxonomy Tab 

5. Click on the Taxonomy Tab. 

 

6. To assign Taxonomy to this folder disable Inherit Parent Configuration.  

7. Select the Taxonomy to be assigned to the folder. 

Templates Tab 

8. Click on the Templates Tab. 

9. Uncheck Inherit Parent Configuration if you want to assign a different template. If you leave the Inherit 
Parent Configuration enabled it will use the template defined in the parent folder. 

 

10. On the [Select Template] dropdown list, click on the desired template to select it. 

11. Click on  to the right of the template dropdown to add the template to the Page Templates list. 

12. Click the radio button next to the desired template to set it as default template for that folder.  
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13. Click on View to view a template. 

14. Click Remove to remove templates that will not be used in this folder. 

15. Click OK to confirm that you want to delete the unwanted template. 

NOTE: As Best Practice, those folders that will not contain any PageBuilder Pages should only have one template assigned 
it. Those folders that will have PageBuilder page can have more than one PageBuilder Wireframe Template assigned to it. 

16. Click the Update button ( ) to save the folder setting. 

Smart Forms Tab 

17. Click on the Smart Forms Tab. 

18. To disable all SmartForms so you can add any type of content into the folder. 

 

a. Disable Inherit Parent Configuration. 

b. Disable Require Smart Forms. 

 

c. Remove any Smart Forms. 

d. Set Blank HTML as Default. 
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19. To Add Smart Forms to a folder. 
NOTE: Best Practice is to assign only one Smart Form per folder. 

a. Disable Inherit Parent Configuration. 

b. Select the Smart Form to add to the folder from the Select Smart Form dropdown box. 

c. Click on  to the right of the dropdown box. 

d. Set this Smart Form as default. 

e. Enable Require Smart Forms. This will allow only content created using this Smart Form to reside in this 
folder. 

 

Other Folder Properties 

The Flagging, Metadata, Web Alerts and Breadcrumb folder properties are not being used or if used should only be 
configured by the Administrator. 

Copying and Moving Folders 

1. Right Click on the folder you wish to move. 

2. Select Cut Test Folder. 



  

328 | P a g e  

 

 

Note: To copy a folder with all of it’s permissions and properties select copy folder and continue with the next steps. 

3. Select the main Folder above the Test Folder. 

4. Right Click on Content and select Paste Folder 

5. Select OK from the pop up window that will appear to warn you that all properties will remain the same when 
you move the folder. 

 

Your folder will now appear beneath the main folder for that section. 
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Setting Folder Permissions 
Reference: “Permissions” chapter in Ektron CMS400.NET Reference Manual. 

1. On the Content tab, select “Test Folder”. 

2. On the View menu, select Folder Properties. 

3. Click the View Permissions button ( ). 

4. Uncheck Allow this object to inherit permissions, then click OK on the popup message. 

5. Click the Add Permission button ( ). 

6. Select the following CMS groups below to add to folder:  

Content Approvers – Full Permissions, as well as advanced permissions 

Content Editors – Read Only, Edit, Add, Delete, Library read only, Add images 

Content Publishers – Read Only 

Group 1 – Read only, edit, add, delete, library read only, add images 

Manager1 – Full Permissions, as well as advanced permissions 
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7. Click the Save button ( ). 

8. Click the Delete Permission button ( ) and select “Everyone”.  

9. Click the Delete Permission button ( ) and select “jedit”. 

10. Click OK in the pop up to delete the Everyone Group’s permissions for this folder. 
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Appendix C –Workarea/Editor Quick 
Reference Version 3.0 
Workarea - Content 

 

1. Work area Tabs 

 Desktop  smart personalization desktop  

 Content  Locate folders, contents, DMS, taxonomies, collections and menus 

 Library  Content folder structure, stores images, files , hyperlinks and quick links 

 Settings   Manage CMS Settings based upon permissions 

 Reports  Content reports and Site analytics 

 Help   In Work area and in context help section 

Content Tab Types 
2 - Folder Tab Select to view folder architect structure of CMS 

3 - Taxonomy Tab Select to view Taxonomy Structure and options 

4 - Collections Tab Select to view Collections and options 

5 - Menu Tab Select to view Menus and options 
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Folder Types 
6 - Content Folder Regular folder for contents, select to view contents in that folder. 

7 - Blog Folder Select to view the posts and comments on this blog. 

8 - Forum Folder Select to view the discussion forums, categories, topics, and replies. 

9 - eCommerce Folder   Select to view the ecommerce items 

10 - Calendar Folder Select to view and plan events on the calendar 

11 - Community Folder Folders for membership uses to edit content, select to view contents. 

Dropdown Menus 
12 - New menu Create new content, forms documents, Folders menus and collections 

13 - View menu View Language, Properties and archived content and more. 

14 - Delete menu Used to delete multiple items. Administrators can delete folders. 

15 - Action menu Export for translation, Search, move/copy content, eSync 

16 - DMS/ Add asset   Pop up the window for drag and drop documents from local machine. 

17 - In Context Help   Click to get in context help anywhere in the work area 

18 - Content Organization Bar   Ability to sort content by the title 

Content Types 
19 - Content Items can be HTML Content, Forms, DMS, or Multimedia Content 

20 - Quick Edit Menu for content editing, properties and content esync. 

21 - Language Flag   indicate the content language version. 

22 - Content ID Automatically generated by system. 

23 - Content Status shows the current status of a piece of content.  

 (A) Approved Published and on the website. 

 (O) Checked Out only available for editing by the content editor who checked it out. 

 (I) Checked In Available for editing.   

 (S) Submitted currently in the approval chain. Waiting for acceptance. 

 (M) Deletion Marked for deletion. 

 (T) Awaiting Tasks Currently awaiting completion of tasks. 

 (P) Pending Awaiting scheduled start date. 

 (D) Pending Deletion Pending deletion but created with a future start date. 

24 - Date Modified last modified date of the content. 

25 - Last Editor who made the last modification. 
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eWebEdit400 Cheat Sheet 

 

1. Content Options (From left to right) 

 Publish / Submit – Saves changes, closes editor, and (depending on approval rights) 
either publishes the content or submits it to the next person in the approval chain. 

 Check in – Saves changes, closes editor, checks in the content, but does not publish or 
submit for approval.  
Note: Use this to create a record in the history, and to allow other content authors to 
edit it.  

 Save – Saves changes; does not submit into the approval chain, check content in or even 
close the editor. 

 Preview- Allows you to preview the content as it would look in context. 

 Cancel – Discards changes, cancels check out. 

2. Title – The CMS title for the current block of content. 

3. Language – Indicate the content language. 

Tabs 

4. Content Tab – Default tab; select to view/modify the main body of content. 

5. Summary Tab – Click this tab to view/modify the brief summary of a content block.  

6. Metadata Tab – Click this tab to view/modify metadata values related to this content block. Used for 
search engine optimization, advanced search/navigation, content relationships, etcetera. 
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7. Alias Tab (Optional) – Click to create alias (friend URL) for content. 

8. Schedule Tab – Click this tab to view / set the go live and end dates for this content block, and the 
action taken when the end date occurs.   

9. Comments Tab – Click this tab to view/modify a comment viewable by content authors/publishers 
only. 

10. Web Alerts (Optional) – Click this tab to modify settings for email notification to subscribers. 
Administrators set the defaults and identify which folders are included in a subscription. 

11. Templates (Optional) – Click this tab to select an alternate template to display this content block. 
Administrators specify which choices are available / appropriate. 

12. Category (Optional) – Click to select taxonomy for content. Administrator specifies the taxonomy can 
be used in folder properties. 

13. Standard Toolbar (From left to right)  

 Select All / Cut / Copy / Paste 

 Paste Plain Text – Paste copied text without formatting. 

 Find and Replace / Print / Undo / Redo 

 Spell Check – Checks content spelling using web based dictionary. 

 Insert Anchor – Creates anchor point within the content. 

 Hyperlink Manager – Insert a hyperlink to anchor link, or modify an existing hyperlink. 

 Remove Link – Remove a selected link. 

 Library – Click to browse the library, allowing you to insert images, links to files/forms, 
links to other content blocks (Quick links), and stored hyperlinks. 

 Adds Wiki Link – Create a Wiki link. 

 Translate content – Click to open translate content window, providing a machine 
translation of your content block into one of a handful of languages. 

 Horizontal Rule – Inserts a horizontal line. 

 Insert Symbol – Insert symbols and special characters. 

 Validation – Checks to make sure all HTML is XHTML compliant. 

14. Style Toolbar 

 Styles – Select and apply style characteristics to selected content, overriding the default 
characteristics. 

 Heading – Similar to styles, applies heading characteristics to selected content, or select 
Normal to remove any formatting to the text. 

15. Formatting Toolbar  

 Bold / Italic / Underline / Strikethrough  

 Superscript / Subscript / Number List / Bullet List  

 Out dent / Indent  

 Align Left / Center / Right / Justify / Remove Alignment 

16. Table Toolbar – For creating and editing table, column, row, and cell properties. 

17. Design View – WYSIWYG view of the content. 

18. HTML View – HTML source of the content. 

19. Property Screen – display properties based what’s been selected in the content body. (Screen shot 
shows Image Properties of the image select in content body.) 
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Appendix D – Training your users 
Resources 

 User Manual  

 CMS400 Dev Center, the online community for CMS users -  
http://dev.Ektron.com 

To illustrate the elements of design that relates to the user training, here is a list of questions 
that need to be answered to plan end user training: 

1. Please provide an overview of the installation - what type of site it is, the goals of the 
project, the timeline of the project, features of the CMS that are especially 
important, unusual or special requirements of the site, other web applications that 
are used, etc. 

2. What areas of the site or pages have received the most development effort? 

3. What are the major types of content on the site? 

4. Are there serial content types like press releases or news articles anywhere? 

5. What XML content types are used? What XML Indexing searches or lists are used? 

6. How does a user add a page to the site? (The answer to this might be "The site isn't 
designed to allow users to add new pages.") 

7. How does a user add a section to the site? (The answer to this might be "The site isn't 
designed to allow users to add new sections.") 

8. How many CMS templates are in the site? How many of these are dynamic and which 
CMS folders do they relate to? 

9. Dynamic Lists: 

a. Where are CMS menus used? 

b. List Summaries? 

c. Archive List Summaries? 

d. Collections? 

e. Other list controls? 

10. Is there any content reuse - content appearing on more than one page? 

11. How would CMS users create new CMS-managed HTML forms? 

12. Are CMS calendars used anywhere? 

13. How would CMS users create new CMS calendars? 

14. How is CMS metadata used? Would CMS users be editing CMS metadata values? 

15. Is it a multi-lingual site? Which languages are enabled?  Who would translate the 
content? 

16. Are there any private content or extranet sections on the site? 

17. What CSS styles are available to CMS users and how would each style be used? 

18. What general styling guidelines should CMS users follow? 

http://dev.ektron.com/
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19. Is there a "palette" of HTML snippets for CMS users to cut and paste from? 

20. How are CMS permissions set? Are administrator users expected to make extensive 
changes to permissions settings? 

21. What approval processes are set up? Are administrator users expected to make 
extensive changes to permissions settings? 

  



 

 

Topics to Cover 
 Business Impact (Note: what users need to know during training often have more to do 

with your business processes and Web site configuration than the features of the CMS.)  

o What is the CMS?  

o What does the CMS do for your organization?  

o How will the Web site change or what will the new site be like?  

 Site layout  

 Appearance and style  

 New Content 

o How will the users’ responsibilities change? 

o Basic demonstration of the CMS  

 Log in to CMS  

 Edit an existing content block  

 Add a new content block  

 Add a hyperlink to the new content block 

 Basic editing process  

o Describe different parts of the editing screen  

o Staging version versus Published version  

o Change control - check in / check out  

o Difference between three save buttons 
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Formatting Content 
1. Explain formatting rules and guidelines for your site - how do you want your users to 

format content?  

2. Two basic formatting approaches:  

a. Cut and paste  

b. "From Scratch" using editor's formatting features 

3. Overview of editing  

a. Word-processor-type features  

b. "Paste text" buttons  

c. Uploading images and files  

d. Creating and editing images  

i. With Ektron's WebImageFX, if you have purchased a license  

ii. Otherwise with Microsoft Paint or another tool available to all users 

e. Web editing techniques  

i. Layout and positioning with tables 

f. Describe the CSS styles that you have created and how users will apply them 

4. XML Content  

a. Demonstrate editing and creating each type of XML content  

b. Explain where the XML content is used on the site and how it is displayed  

c. Demonstrate editing and creating each type of XML content 

5. Other things you can do with content  

a. Scheduling  

b. Translation  

i. Manual Translation  

ii. Export to XLIFF 

6. Permissions - what will particular users be able to do in particular parts of the site?  

7. Approval Process  

a. Explain approval process in general  

b. How to check the status of a content block  

c. Show an approval e-mail  

d. Demonstrate logging in and approving changes  

e. Describe the approval processes set up in the different parts of your site  

i. When a user edits content, who will approve those changes  

ii. Will the users attending training need to approve changes made by 
others? 

8. Work Area  



 

 

a. Demonstrate how a user would edit their profile  

b. Collaboration Tools  

i. Instant E-mail  

ii. Content Change Control  

iii. Content Approval Process  

iv. History Comments, Task Comments, and Inline Comments  

v. Task Management 

vi. Explain any features of work area you'll want your users to access 

9. Closing  

a. Explain your CMS deployment plan and timeline  

i. When will users have access to begin using CMS? 

b. Resources for end users - describe links available in "Help" section of Work 
Area  

Who in your organization should users contact with questions and problems? 
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Appendix E – E-mail in CMS400.net 
E-mail Notification 
See Also: “Configuring E-Mail Notifications” in the Ektron CMS400.NET Setup Manual. 
The following tasks are internal to the CMS and relate to the approval process, which NWRS is not using at this time. 

E-mail notification is sent by the CMS on these occasions: 

 When submitted by a user. 

 A task is assigned to a user. 

 A task is redirected to a user. 

 A task is submitted for content approval. E-mail is sent to the first user in the approval chain. 

 The approval process moves on to the next approver. 

 The content is declined at an approval stage. E-mail is sent to the assigned user. 

 The content is published. E-mails are sent to the creator, assigned user and the approvers. 

Where User Groups are used in lieu of individual users (recommended practice for Approval Chains), all members 
in the group will be sent notification E-mails. (Note: In order to receive system E-mail notifications, a user must 
have their E-mail enabled in the User Setup.) 

 

Example 1 – HTML Form E-mail 
This E-mail is sent when an HTML form is submitted from the site. The E-mail property must be set on the form for 
this to be sent when the form is submitted. 

From: studentRoger@ektron.com [mailto:studentRoger@ektron.com]  
Sent: Tuesday, May 01, 2007 3:09 PM 
To: Roger.kirkhart@ektron.com 
Subject: New Student Form 

  

Data from form "Roger Contact Info" was received on 5/1/2007 3:08:33 PM. 

Contact information. 

Field Value 

Subject Contact Form 

Full Name Roger 

Address 1 street 

City city 

State South Carolina 

Zip 11111 

Country USA 
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Business Phone 603-888-1234 

Home Phone 603-888-1234 

E-mail Address roger.kirkhart@ektron.com 

E-mail "New Student Form" originally sent to Roger.kirkhart@ektron.com from studentRoger@ektron.com 
on 5/1/2007 3:08:33 PM. 

Example 2 – Content Request for Approval 
From: rogerstudent@ektron.com [mailto:rogerstudent@ektron.com]  
Sent: Tuesday, May 01, 2007 1:31 PM 
To: roger.kirkhart@ektron.com 
Subject: Request for content approval 

The content Editor adds new content has been submitted for your approval by editor". 
 
To locate the content, the folder path in your workarea is: \CMS400Demo\Test Folder. 
 
The following link will take you to the submitted content block on the Web site: 
http://localhost/CMS400Developer/login.aspx?id=858&LangType=1033 
. 
Please Note: You must login and select the preview icon to view the changes. 
 
The content was submitted for approval on: 01-May-2007 1:30:46 PM. 
 
Approvals: [approver] 
 
Comment:  

Example 3 – Content Approved and Published 
From: rogerstudent@ektron.com [mailto:rogerstudent@ektron.com]  
Sent: Tuesday, May 01, 2007 2:49 PM 
To: roger.kirkhart@ektron.com 
Subject: Content changes have been made 

The changes to the content About Us have been approved. The content changes went live immediately. 

Example 4 – Content Declined Approval 
Content sent for approval was declined and an E-mail was returned to the content author. The content is in a 
“Checked In” state. 

From: rogerstudent@ektron.com [mailto:rogerstudent@ektron.com]  
Sent: Tuesday, May 01, 2007 1:32 PM 
To: roger.kirkhart@ektron.com 
Subject: Content approval request declined 

Your submitted approval request for the content Editor adds new content has been declined by approver. 
Reason: I DON’T LIKE IT. 

mailto:Roger.kirkhart@ektron.com
mailto:studentRoger@ektron.com
http://localhost/CMS400Demo/login.aspx?id=858&LangType=1033


 

Page | 343 
 

Example 5 – Membership Approved 
Activate Account 

From: Training@ektron.com 
To: roger.kirkhart@ektron.com 

Welcome to the Ektron CMS400.NET Web Alerts system. 

You have registered to receive updates from our Web site when content is added or updated. 

For security and identity reasons, you must active your account by clicking the link displayed below. 

http://localhost/CMS400Developer/WorkArea/activateuser.aspx?uid=jmember&acc=797c9c3297f449e896
531cd379900ce0 

Make note of your username and password: 

Your user name is: roger.kirkhart@ektron.com. 

Your account id is: 797c9c3297f449e896531cd379900ce0 

Example 6 – Web Alert E-mail Example (including new article text) 
From: Training@ektron.com 

Sent: Wednesday, June 20, 2007 9:18 AM 
To: roger.kirkhart@ektron.com 
Subject: Wellness Article Update!!! 

You have received this newsletter because you subscribed to it on the Ektron Medical Web site. If you do 
not wish to receive similar messages in the future, go to the bottom of this page and use the "Unsubscribe" 
link. 

Don't Get Cancer 

by: Simon Mitchell, Ektron 

One antidote to cancer is information 

In general our responses to cancer are converging, but very slowly. Presently all cancer authorities are 
agreed on only one thing: cancer cannot take hold in a healthy immune system 

<remainder of article removed for brevity> 

Read More: http://localhost/CMS400Developer/wellness_article.aspx?id=119 

You have been subscribed to receive E-mail alerts from the Ektron Medical Demo site web alerts system. 
Follow the link to unsubscribe from these alerts: 

http://localhost/CMS400Developer/wellness_alerts_unsubscribe.aspx 

 

  

mailto:Training@ektron.com
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Appendix F - New Analytics 
Why Use Analytics? 
By analyzing the user traffic coming to and interacting with your site, you can better understand key elements of 
your Web presence. Traditional Web analytics packages help you understand where your traffic is coming from, 
when the traffic is occurring (including high and low points) and what pages users are interacting with. But this 
information is often isolated from the Web content and is, therefore, lacking the context needed to take 
advantage of it. 

Ektron CMS400.NET has a fully-developed, Web traffic analytics provider model. By hooking into best-of-breed 
analytics software, like Google Analytics, your Web site’s information is integrated into CMS400.NET’s Work area 
and so is at your fingertips as you use it to optimize the site experience. 

Analytics can help you 
 determine the popularity of areas of your site 

 examine click-through rates on your calls to action 

 analyze site structure and navigation 

 obtain key information about your site visitors 

This information is essential to optimizing your site’s content. Its seamless integration into CMS400.NET lets you 
fully leverage the data. 

Using Analytics Data within Ektron CMS400.NET 

Ektron CMS400.NET’s Work area provides customized reporting, reflecting exactly the information you care about. 
The data can be broken down in many ways, such as 

 number of visits per day 

 browser usage 

 visitor location 

 visitor language 

 top content 

 referring sites 

Analytics data is available for your entire site as well as individual pages. A sample Analytics display is below. 
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The Analytics widget can be placed on your dashboard, so that you have instant access. Also, the software is 
integrated into the content history. This makes your traffic analytics more relevant: you can see what 
modifications were made, when, and how they 

Impact traffic to that page, you can react immediately, restoring content that performed better or changing the 
current content to better reflect your goals. 

This full integration makes your analysis more efficient; there is no reconfiguration of the analytics tool and no 
learning curve.  

Customer reporting, segmentation, and legacy data are easier to access, and Ektron CMS400.NET becomes the 
central hub for all of your Web site’s information, bringing it together so that it is no longer siloed. Having all 
information in one place puts it in context, making it easier to draw the conclusions you need to optimize your 
Web presence. 
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The Flow of Analytics Data 

 
As shown above, once you set up Analytics tracking, the Analytics Provider monitors every site visit. In the 
Workarea, you can view this data from many angles. 

Important: No data is stored in Ektron CMS400.NET -- the CMS retrieves it upon demand from your Analytics provider. 

Google Analytics Provider 
Google Analytics is an enterprise-class, Web Analytics solution that gives you rich insights into your Web site traffic 
and marketing effectiveness. Powerful, flexible and easy-to-use features let you see and analyze your traffic data in 
an entirely new way. With Google Analytics, you're more prepared to write better-targeted ads, strengthen your 
marketing initiatives, and create higher converting Web sites. 

Its main features are: 

 Advertising ROI - Measure the success of your display, search, new media and offline advertising 
efforts. 

 Cross Channel and Multimedia Tracking - Compare your site usage metrics with industry averages and 
track Flash, video, and social networking sites and applications. 

 Visualizing Data - Uncover trends, patterns, and key comparisons with funnel visualization, motion 
charts, mapping, and more. 

 Customized Reporting - Create the reports, dashboards, and segments that make the most sense for 
your business. 

 Sharing and Communicating - Administration controls and email reports allow you to share data across 
your organization. 

 Google Integration and Reliability - Google Analytics complements a suite of related products, all 
running on the same world renowned infrastructure that powers Google. 
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Authorization to View Analytics Data 

License Requirements 
Ektron CMS400.NET Professional or Enterprise License 

User Permissions 
Only the following users can view Analytics data. 

 Members of the Administrators Group 

 Users assigned to the Analytics Viewer role. 

Alfred works for ABC Corp and wants to know what the site analytics are used for. He wants to construct a new 
marketing campaign and wants to know how much traffic is currently looking at the content with the correct 
subject matter that is already there. This will help Alfred to determine if marketing in this direction would be worth 
while for his company. 

Alfred has two choices on viewing the data on his current website: 

Viewing Analytics Data 

The Analytics feature provides two basic types of data: 

 Page data 

 Site data 
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Page Level Analytics Data 
After you enable Analytics tracking, your provider retains data on every visited page (that is, a unique URL) such as 
http://dev.ektron.com/articles.aspx or http://dev.ektron.com/ 

template.aspx?id=6572). Data is tracked when the quicklink is used, as well as any alias assigned to the content. 

Viewing Page-Level Analytics from the Site 
Any authorized user can view Analytics for a page on your Web site by following these steps. Alfred has the correct 
permissions so how does he view page level analytics? This is how: 

1. Log in to the Web site. 

2. Navigate to the page whose Analytics data you wish to view. 

3. Hover the cursor over the Web Site Content menu. 

4. Click View Page Activity, as shown below. 

 

The SEO page’s Traffic tab appears. 
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 Bounce rate - the percentage of single-page visits (that is, visits in which the visitor exited your site 
from the entrance page) This shows Alfred how many people were looking for information but then 
decided that his company wasn’t a good fit after seeing the first page. 

 % Exit - the percentage of site exits that occurred from this Page 

This shows Alfred how many people left after looking at this particular page and deciding that his 
company wasn’t a good fit. This helps Alfred by showing him how many people were interested in this 
particular page but then left. Perhaps there was something on the page that was turning customers off 
to his products that he needs to investigate. 
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Viewing Page-Level Analytics from a PageBuilder Page 
Any authorized user can view Analytics for a PageBuilder page by following these steps. 

Note: You cannot drag and drop the Analytics widget onto a PageBuilder page. 

1. Use the right arrow button (circled below) to open the PageBuilder menu. 

 

2. From the menu, select View > Analytics. 

 

3. The SEO page’s Traffic tab appears. 

Alfred has logged into the CMS and is in the work area, how does he see page analytics from the work 
area? Here is how. 

  



 

Page | 351 
 

Viewing Page-Level Analytics from the Work area 
The Ektron CMS400.NET Work area provides two page-level views of Analytics data. 

 The View Content History screen - compares Analytics data for any two published versions 

 The Analytics toolbar button - displays the SEO page’s Traffic tab. 

To view a content item’s Analytics data from the Ektron CMS400.NET Work area, follow these steps. 

1. Navigate to the folder containing the content whose Analytics data you want to view. 

2. Click the content item. 

 

Alfred recently identified that the wrong message was being sent out with one particular piece of content and 
suspects the contents wording may have been causing confusion in the need for his products or services. So he 
decided to change the content to clear up the misconception. After a few weeks Alfred decides to see if there are 
any notable differences in traffic. He can now do this. He simply compares the two content versions to see if there 
is any difference in traffic. How does the accomplish this? Simple… 

Comparing Two Published Versions of Content 
On the View Content History screen, blue and orange radio buttons appear next to each published version of 
content, as shown below. 

 

To compare Analytics data, click the appropriately-colored radio button next to each version, then click the 
Compare button 
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Alfred spent a great deal of money on a third party consultant to organize his content using URL aliasing. After 
paying the initial cost Alfred is suffering from buyers remorse, how does he know If his companys investment was 
worth the money. It would definitely help to justify the cost if he could show his CEO the improvement in hard 
data. He can now using the analytics: 

URL Filtering 
The URL Filtering tab of the Compare Analytics screen lets you break down the data by each of these identifiers. 
So, for example, you can drill down to view only the data collected when site visitors accessed a page by typing its 
manual alias into the browser. 

 

The above information has been FANTASTIC for Alfred as he can see the data he needs at any time. But bouncing 
between site and drop downs and methods has gotten a little annoying. Alfred would also like to keep an eye on 
how things are going but he doesn’t want to have to repeat the above processes every time. Alfred quickly 
discovers he can use the smart desktop with the reports to see the data the first time he logs into the workarea 
and can monitor it from there without having to bounce all over the place. Here is how he accomplishes that: 
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Site Level Analytics Data 
You can view Analytics data for any site via the Analytics Report Widget and several reports. 

 

Hard Data. CEO’s and COO’s prefer hard data. The wish to have this information available to them at any time 
without having to know what the information was ahead of time and compare to right now. Alfred steps in to help 
by showing his CEO And COO exactly how they can get the information when they need it and how they need it.  

Alfred also knows that he will more then likely have to provide this information daily or quarterly as his CEO and 
COO cant be bothered to run reports every time they need it. Isn’t that what they are paying Alfred for? 

Here is how he gets at the information 
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Site Reports: 

 
 

Available Reports 
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Visitors 

 

Visitor Trending 

 

Browser Capabilities 

Optimizing your site for the appropriate technical capabilities helps make your site more engaging and usable and 
can result in higher conversion rates and more sales. 
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Network Properties 

 

Traffic Sources 

 

Content 
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Appendix G - Best Practices for 
Migrating Content  
Develop a Detailed Content Inventory 
A well planned content migration must begin with a content inventory. This isn’t a simple site map, or cursory 
glance at your file structure. This is a detailed listing of all of your site’s content, and the unique relationships that 
exist between the content. It identifies things such as the URLs, doctype (HTML, PDF, Image etc.), links to and from 
each piece of content, template identification & mapping, orphaned files, stale files (rarely accessed according to 
analytics), and potential meta data. Expect to spend several weeks on this if you are migrating to a large web site. 

Know the Systems Path Required to Migrate Content 
Migrating content often requires logging into, and moving between several systems. This can include the source 
web server, the new CMS, the authoring tool of choice, the task tracking application, the VPN software and more. 
It all adds up and must be done for each piece of content. 

Clean Your Content Prior to Migration 
More often than not, legacy content must be cleaned before it can be imported into a new content management 
system. Frequently this can be automated, but even then a person is usually required to manually edit the content 
to make sure that the formatting is correct in the new system. This is one of the most time consuming steps in a 
migration. 

Create Redirects to Avoid Breaking Bookmarks or Embedded Links 
Often in a migration into a new content management system the URLs will change to reflect a new directory 
structure. When this occurs, any bookmarks to the old site that users might have, or any links embedded in online 
and offline advertisements will break. To resolve this, a 301 redirect will have to be created that points every old 
URL to the corresponding content asset in the new system. 

Pay Attention to Migrating Hyperlinks Properly 
Similar to the issue with redirects, if you migrate your site into a new directory structure, most of your hyperlinks 
will break. When these are fixed manually, it can be a very time consuming process. 

Create Metadata Manually and Automatically 
Content management systems often require a well defined metadata strategy to function properly. Some of this 
metadata can be defaulted automatically, but to be truly useful at least some of the metadata must be manually 
added to each piece of content. This step is especially prone to errors and even the smallest mistakes can require 
massive rework. 

 

Break Up Content for Better Management and Display 
Part and parcel to modern content management systems is the concept of one to many relationships between 
content. Essentially, you break your legacy content up into smaller chunks so that they can be reused across your 
site. The key time drain here is that when you break a piece of content up into chunks, you effectively create 
multiple new pieces of content, with each piece needing separate meta tagging and link resolution. This can 
compound the scope of your migration very quickly.  

 

Perform Quality Assurance Tests 

Performing quality assurance on a newly migrated web site is a significant task. Most organizations prefer to check 
every single page and without automation you can expect at least a few minutes per page that was migrated. 
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Terminology  

 

 Content Management System (CMS) - The backbone of the NWRS Web presence. The CMS is one part database, 
holding all of the text and media for all NWRS Web sites, and one part user interface, where Web authors input 
content for their sites. 

 

Page Level Specs (PLS) - The detailed guidance document containing all of the ins and outs of the Web page 
templates, including colors, image sizes, fonts, etc. If you think of this is a Quick Start Guide, then the PLS is the 
Owner’s Manual. 

 

Threespot - The company that designed the visual templates (the “look and feel”) for the Web sites. 

 

Ektron - The company that developed the Content Management System and the user interface that Web authors 
use to upload content to their site.  

 

Approval Chains – Similar to permissions in that they restrict publishing rights to a given piece of content In 
Ektron, these refer to a linear work flow, with each approval simply moving the content to the inbox of the next 
approver. 
 

Asset - An asset is anything that is stored within the Content Management System (CMS).  For example, images, 
documents, multimedia, and even content can be considered as an asset. 

 

Collection - A collection is a list of content links.  The list can only contain links from within the CMS.  A collection 
list can be ordered by a content contributor.  Link examples are internal content, documents, multimedia, and 
image links 
 

Collection Selector - A collection selector is a Metadata type that allows a contributor to associate collection to a 
content block. 
 

Content Block - A Web site consists of several pages. Each page is made up of one or more blocks of content.  A 
content block is information contained as one block.   

 

Content Selector - A content selector is a Metadata type that allows a contributor to associate another piece of 
content to a content block. 

 

Flex Menu – A server control used to render menus in the Ektron Framework. It supports richer interfaces and 
complex configurations. 

 

Folder Aliasing – Similar to taxonomy aliasing, with the difference that folder aliases use the folder structure of the 
content tree to derive their URL aliases. This is useful when you have a meaningful and logical structure to your 
content tree and want to expose content using this folder structure. 

 

Home Page – used to promote content that exists throughout the site.  The home page has been divided into 
multiple promotional spaces to attract a variety of users. It should be used to highlight the diversity of the site. 

 

HTML Forms – Allow you to build traditional HTML forms containing standard import elements such as text boxes 
and options and option lists, with the added ability to define client-side form validation rules, enable spell 
checking, and more, all using the WYSIWYG authoring environment. 

 

Hyperlinks – External links, links that point web pages outside of your web site. 
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Landing Page – Any page, regardless of the template used, that acts as a directional or way finding “home page” 
for multipage sections of a Web site. This page must have left navigation box. 

 

Library - The CMS Library is a place that stores and allows access to files, forms, hyperlinks, image, multimedia, and 
quick links.  The County will be using the Library for image, multimedia, and forms. 

 

Manual Aliasing – Offers content editors tight control over URL aliases assigned to content items. You use this 
when a URL falls outside the patterns defined by other types if aliasing.or when you need to override automatically 
generated URL’s. 
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Menu - A menu is a list of page links that can be structured hierarchy.  The list can contain links from within and 
outside of the CMS.  A menu hierarchy can be organized by a content contributor.  

 Main Navigation – Or commonly referred to as Main Menu is the primary menu that appears near the top 
of every page. Each main menu item links to it’s respecting landing page. 

 
 Footer Navigation – Or commonly referred to as Footer Menu are supplemental menu that appears at the 

bottom of every page.  

 
 

Metadata - Metadata describes other data. It provides information about a certain item's content.  

Most content items within the CMS will include metadata.  Ektron uses metadata in two ways.   

 Describes the content with the content block like title, keywords and description.  

 Groups associated information together like menus, collections and other content blocks.  

 

Quicklinks – Internal links automatically created by CMS400.NET. 

 

PageBuilder – Ektron technology that provides the framework from which widgets and wireframes are used by 
CMS editors to create the web site pages. 

 

Persistent Promo/Element – Document once but persistent on all refuge site pages. 

 

SmartForm – An ideal way to handle content that follows a very structured format. The data is stored internally as 
XML, and the definition contains information necessary to create the form. 

 

Template - a tool used to separate content from presentation in web design, and for mass-production of web 
documents. It is a basic component of a web template system. 

 

 

 


